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INTRODUCTION AND OVERVIEW For more than 10 years now, landscape architects and other  
site design professionals have increasingly been considering  
the process of Building Information Modeling (BIM) for their  
own firm’s practice. Of course, those employed within an 
architecturally focused multidisciplinary firm were the first to feel 
the pressure from coworkers to implement BIM, so exchanging files 
between building and site teams using the same software provided  
a perception that these workflows worked for each team. Meanwhile, 
other landscape architecture firms became increasingly motivated 
by external architects and building design professionals to consider 
switching from conventional CAD workflows. Additionally, jurisdictional 
standards and corporate mandates have provided little room for these 
professionals to do anything but switch. And interestingly enough,  
a growing number of landscape architects and landscape designers 
who are not feeling the pressure to switch have still sought to know 
more about this BIM process, because word has spread about 
the ultimate efficiencies found in designing, modeling, analyzing, 
and reporting. The only challenge that remains for all of these 
professionals considering the switch is to determine what BIM  
means for them in the landscape industries, and how do they use  
and collaborate effectively in these workflows.
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BIM COLLABORATION WITH IFC

ADVANTAGES WITH VECTORWORKS LANDMARK

BIM FOR LANDSCAPE

Vectorworks Landmark offers the site design professional BIM 
workflows which can be intuitively integrated into their workflow. 
Landscape-focused tools such as plants, landscape areas,  
hardscapes, terrain models, and irrigation provide purpose-built  
2D and 3D objects, which carry the information needed from  
those objects to enable analysis and documentation just like  
the building-focused tools do in architectural BIM software  
without the compromises.

BIM COLLABORATION

For collaboration with other BIM-participating professionals, 
Vectorworks Landmark operates through the non-proprietary  
BIM format “Industry Foundation Classes” (IFC). Firms can export  
and share a data-rich model, treated consistently among other  
BIM software, as well as analyze with user-defined criteria within 
model checking software like Solibri. These file exchanges not only 
share object geometry, but data — such as material information 
within the proposed features, compliance factors, and maintenance 
instructions — exchange smoothly as well. Some firms also benefit 
from geospatial management of exported data to inform  
earth-moving equipment to affect the proposed changes to the site’s 
terrain and to georeference their BIM model for GIS scene creation.

WHAT IS IFC?
IFC, or Industry Foundation Classes, is an international standardized 
open-source file format, developed by the non-profit organization 
buildingSMART International, who have optimized the format for BIM. 

Much like PDF or HTML, the specification for the code to write this 
file format is freely available to the public and to developers for the 
creation of their own tools to handle the data format. This means that 
all software vendors have equal access to the specifications and can 
create the necessary import and export technology. No single vendor 
controls this format or profits from licensing the technology.

The most important thing to remember is that IFC encodes both 
geometry and data, making IFC the ideal for an open BIM exchange. 

The IFC file format includes:

GEOMETRY - IFC geometry is robust and includes vectors, solids, 
surfaces, etc. to define the appearance of objects.

DATA - IFC supports three main aspects of the data in a BIM model:

	∙ Semantics - the meaning or identity of a collection of geometry 
related to the proposed constructed objects, such as a plant  
shown on the site’s surface.

http://vectorworks.net
http://vectorworks.net
https://www.buildingsmart.org
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BIM COLLABORATION WITH IFC

	∙ Relationships - speaks to how the geometry are related to each 
other, such as a door inserted into a wall or a plant inserted into  
a terrain’s surface.

	∙ Properties - definition of materials that includes data,  
such as cost or model number.

Though many of the site-specific objects in Vectorworks Landmark 
are intelligent with their own built-in appended data, the IFC tagging 
relies heavily on the use of IfcBuildingElementProxy with custom 
naming rules and property sets to define them. Keep in mind that 
although the established nomenclature and schema seem most 
relevant to buildings, this will not always be the case. According to 
buildingSMART’s article IFC for Site, Landscape, and Urban Planning 
– call for participation:

“...a great deal of work is being undertaken by many parties 
in the buildingSMART International community to address 
how the IFC schema can be extended to express built 
infrastructure – roads, railways, bridges, tunnels, and more...”

Within landscape-focused BIM workflows, and considering the 
nature of BIM file exchanges, using the closest-related IFC schema 
and tagging for each site element will ensure the data shared with 
the site object geometry is still meaningful and informative. More 
will be shared about these tagging recommendations, but it is good 
to recognize where IFC development will continue to support site, 
landscape, and urban planning/design in the near future.

WHY IFC IS IMPORTANT
Being an open-source file format, IFC supports a more collaborative 
BIM process, allowing each project stakeholder to make meaningful 
contributions to the project using the best-suited tool for the job. 
Every member of the project team has different needs and different 
end-goals, meaning that each of them uses their own BIM model for 
different purposes and to gather or generate different data. There is  
no single application that can fulfill all these different uses and needs.  
If each project member is able to use the tool of their choice, then 
they are able to do their part in an efficient, effective, and executable 
manner, all the while creating a model that can be shared and 
effectively used throughout the BIM process.

For firms that previously committed drawings and/or models to the 
architecture firm to then transform that geometry into a BIM model for 
submission, the ownership of your site project contribution will become 
another benefit in using the IFC file format. Other benefits include: 
being independent of limitations of versioning found in proprietary 
file formats, portability and accessibility of project information from 
different applications, and the extensibility of an IFC file

WHAT DOES IFC MEAN FOR  
VECTORWORKS LANDMARK USERS?
For Vectorworks Landmark users, IFC is the file format needed to 
share both the geometry and data of their landscape BIM models  
with other project team members, such as the project owner, the 
project consultants, the construction manager, or others who may  
not be using Vectorworks. 

https://www.buildingsmart.org/ifc-for-site-landscape-and-urban-planning-call-for-participation/
https://www.buildingsmart.org/ifc-for-site-landscape-and-urban-planning-call-for-participation/
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BIM COLLABORATION WITH IFC

Vectorworks supports BIM interoperability using the IFC file format. 
Vectorworks Landmark currently supports IFC versions 2x2, 2x3, and 4. 
Though the 2x3 version may be the most supported, version 4 includes 
support for features such as georeferencing, which can be very helpful 
in site file exchanges. As more applications move towards supporting 
version 4, the need to use 2x3 will decrease. Vectorworks Landmark 
has been certified by buildingSMART International for the export of 
models based on the IFC2x3 Coordination View 2.0 – Architecture 
model view definition, as well as the import of any IFC2x3 Coordination 
View 2.0 model.

IFC OBJECTS IN VECTORWORKS LANDMARK
Vectorworks Landmark provides you with the necessary tools to 
create a complete and useful IFC model of the site. Every object is 
enabled to be tagged for IFC export, requiring minimum user effort. 
This is especially true for the purpose-built smart objects like plants, 
hardscapes, landscape areas, etc. as these objects have default IFC 
property definitions. These default definitions will be covered in the 
section IFC Object Tags for Standard Site Objects. 

For objects with no pre-assigned IFC property definition, or for users 
who would like to append additional ones, it is easy to manually assign 
property definitions. With the Attach IFC command, you can assign IFC 
object tags and properties to BIM objects like plants, hardscapes, and 
stairs as well as custom-built geometry, so applications that read IFC 
files can identify these objects. 

Additionally, when IFC files are imported into Vectorworks, the  
IFC objects within the file are brought in as a particular and flexible 
kind of plug-in object called an IFC Entity. An IFC Entity, as opposed 
to a Vectorworks object, is created because the properties of 
objects created in other programs cannot easily be matched to all 
the corresponding Vectorworks object properties and controlling 
parameters. For more detailed information on the export and import  
of IFC files, see the Exporting and Importing sections of this guide.

FIGURE 1: IFC Objects in Vectorworks Landmark

http://vectorworks.net
http://vectorworks.net
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BIM COLLABORATION WITH IFC

When using the existing semantic definitions of an IFC Entity, such as 
an IfcStair, IfcWall, or IfcRailing, the definitions are maintained and 
displayed. Like a group or symbol, an IFC Entity can contain a collection 
of geometry and has sets of data and properties attached to it. Also,  
the IFC Entity can act like a plug-in object and be inserted into walls. 
This may initially sound strange, but imagine designing a wall fountain. 
This would be a good example of an object that would need to have 
its own IFC record and be inserted within a wall for appropriate 
representation in the BIM model.

IFC OBJECTS AND PROPERTY SETS

An IFC object is a building or site object that has been defined by  
both its occurrence and type. This means that a site object created  
in Vectorworks, either with the default tools or a user-created object, 
can be tagged as an IFC object to define its semantics, properties, 
 and relationships to other site objects.

When an object is tagged for IFC, it is assigned an IFC Property 
Definition known as a property set (pSet). An IFC Property Definition 
captures an object’s property set, or associative data. This set of 
properties is attached to the object. More than one property set  
can be associated with an IFC object, including custom property sets 
that are defined by the Vectorworks user.

IFC OBJECT TAGS FOR STANDARD SITE OBJECTS

Vectorworks Landmark (and Vectorworks Designer) contains  
site-specific tools and features which provide the landscape architect, 
landscape designer, and land planner with purpose-built elements  
to simplify their design and documentation process. In many cases,  
the objects designed into the project have a 2D representation  
as well as a 3D representation to create a virtualized model to plan, 
analyze, visualize, and report holistically. This provides an advantage 
over traditional 2D design methods, especially when site-specific 
data cannot easily be appended or harvested from the elements 
incorporated in the design.

The challenge, however, comes when firms who are used to  
2D workflows, manual labeling, and disintegrated reporting because 
the interconnected relationship of the data and geometry available 
with BIM workflows forces these same professionals to approach 
design with smart tools more holistically. This challenge is not 
insurmountable; in fact, once the firms commit to designing in BIM 
workflows, they will quickly begin to recognize the overall efficiencies 
with smart objects, parametric modeling, and as we are discussing  
in this guide, the ability to exchange the data and geometry from  
the landscape project model with other collaborators who need  
this information to continue their iterative design process.

This section shares recommendations for how typical site elements 
proposed in a project model should be designated as IFC objects. 
These suggestions are based on the element’s function/s and 
components (geometric representation). The IFC tag is the default  
IFC property definition assigned to each object type.
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BIM COLLABORATION WITH IFC

HARDSCAPE ROAD

Smart Object Yes Yes

Toolset Site Planning Site Planning

Function Pavement / hard surface  
(i.e. plaza, patio, path, driveway, 
pedestal decking, sport court)

Pavement / hard surface  
(i.e. street, road, bike path,  
cul-de-sac)

Components Horizontal strata

Texture bed 
(No depth)

Drainage tools

Surface modifiers  
(To alter the terrain surface)

Align to site elements

Surface and curb

Surface modifiers  
(To alter the terrain surface)

IFC Tag IfcSlab IfcBuildingElementProxy

FIGURE 3: Vehicular surface represented by Road Object  
(Image courtesy of Pacific Coast Land Design)

FIGURE 2: Walking surface represented by Hardscape Object  
(Image courtesy of Huitt Zollars)

http://vectorworks.net
http://vectorworks.net
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FIGURE 4: Parking represented by Parking Along Path Object  
(Image courtesy of Holcombe Norton Partners)

FIGURE 5: Trees and understory represented by Plant Object

BIM COLLABORATION WITH IFC

PARKING PLANTING

Smart Object Yes  
(Parking Area, Parking Along Path  
and Parking Spaces)

Yes  
(Existing Tree, Plant)

Toolset Site Planning Site Planning

Function Used in conjunction  
with Hardscape Object  
(For layered surface 
representation and drainage)

Individual, hedged  
or massed planting

Components Spaces and drive aisles 
(Parking spaces can be counted 
and customized for accessibility 
codes)

2D Plan symbol 
(Customizable)

3D Generated plant form 
(Best for IFC exchanges)

3D Image prop  
(Best for efficient rendering)

3D Modeled plants  
(i.e. VB Visual, SketchUp,  
Plant Factory, Laubwerk)

IFC Tag IfcSpace IfcBuildingElementProxy
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BIM COLLABORATION WITH IFC

LANDSCAPE AREA SITE MODEL

Smart Object Yes Yes

Toolset Site Planning Landmark Pull-down Menu

Function Mono- and multi- species 
planting; spatial use 
planning; texture bed; 
softscape strata

Digital Terrain Model (DTM)  
(Create, analyze and manage 
elevational grade changes 
with contours and surfaces  
for pre- and post- development)

Components 2D Fill or plant symbol

3D Textured components

3D Texture bed

3D Image props/modeled 
plants

2D Contours  
(Surface flow arrows,  
elevational color fills,  
and slope analysis color fills)

3D Contours 
(Mesh surface, extruded  
contours, elevational color fills, 
and slope analysis color fills)

Displays 3D texture  
bed objects

Calculates cut/fill volumes

IFC Tag IfcBuildingElementProxy IfcSite
FIGURE 7: Terrain surface represented by the Site Model

FIGURE 6: Mass planting represented by Landscape Area

http://vectorworks.net
http://vectorworks.net
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BIM COLLABORATION WITH IFC

FIGURE 8: Guardrail represented by the Railing/Fence object

FIGURE 9: Accessible surface represented by the Ramp object

RAILING/FENCE RAMP

Smart Object Yes Yes

Toolset Site Planning Building Shell

Function Path-based object  
(With settings for fence and  
railing/guardrail applications 
horizontally and terrain-,  
stair- and ramp- following)

Parametric object  
(Controlled by width, height,  
and slope to produce straight and 
turned ramps, including landings)

Components 2D Top rail 

2D Post

2D Bracket

2D Frame/panel

3D Top rail 

3D Post

3D Frame/panel

Ramp  
(Custom thickness) 

Left rail

Right rail

Slope arrow

IFC Tag IfcRailing IfcRamp
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BIM COLLABORATION WITH IFC

STAIR WALL

Smart Object Yes Yes

Toolset Building Shell Site Planning

Function Parametric object  
(Controlled by width, rise height, 
tread depth, as well as step length 
ratio/angle)

Parametric object  
(Controlled by height, width  
[incl. component width], 
component offsets; walls  
can be stepped or sloped)

Components 2D Plan  
(Incl. walk line [direction])

Solid or stringer framed stair

Left railing/posts  
(Incl. guardrail)

Right rail/posts  
(Incl. guardrail)

Return landing

Nosing

2D Plan and 2D section 
(Shows 2D fill in vertical 
component strata)

3D Views  
(Show 3D texture of overall  
wall or component strata)

Displaced Soil Volume 
(Represents displaced soil when 
combined with Retaining Wall  
Site Modifier)

IFC Tag IfcStair IfcWall or 
IfcWallStandardCase

FIGURE 11: Retaining wall represented by the Wall object

FIGURE 10: Stairway represented by the Stair object

http://vectorworks.net
http://vectorworks.net
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FIGURE 12: Buildings on site represented by Massing Models

FIGURE 13: Manufacturer’s BIM content such bimobject (imports as IFCFurnitureElement)

BIM COLLABORATION WITH IFC

BUILDING 
(MASSING MODEL)

BIM OBJECT

Smart Object Yes No

Toolset Site Planning Furn/Fixtures

Function Parametric object  
(Controlled by height,  
footprint path, and roof style)

3D Model of  
manufactured feature  
(With preconfigured 2D and 3D 
representations and appended 
model information)

Components 2D Plan  
(Shows roof or footprint) 

3D Model shell wall

3D Model roof  
(And eave settings)

3D Floor separation

Site Modifier at  
massing bottom

Floor usage data

Dependent on object

IFC Tag IfcBuilding Depends on manufacturer 
(Different IFC properties  
are already assigned here)
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FIGURE 14: Custom elements produced by free-form modeling

FIGURE 15: Custom element produced by Marionette

BIM COLLABORATION WITH IFC

FREE-FORM  
MODELED OBJECT

MARIONETTE OBJECT

Smart Object No Yes 
(If scripted with parameters)

Toolset 3D Modeling and  
Model pull-down menu

Basic

Function 3D Model of  
custom feature  
(Which can be symbolized with 
2D and 3D representations and 
appended material information)

Objects created by 
algorithmic aided design

Components Dependent on object Dependent on object

IFC Tag Depends on manufacturer 
(Different IFC properties  
are already assigned here)

Depending on the object  
(Different IFC properties  
can be assigned)

http://vectorworks.net
http://vectorworks.net
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Though the examples shown and illustrated with typical IFC 
designations represent most of the elements expected to be included 
in a BIM file exchange from the landscape architect or designer 
 via IFC files. The following chart is a more comprehensive list  
of those and other smart and parametric site features along with  
their corresponding IFC object tags. This can be used as a guide  
to determine the appropriate IFC tag for user-defined objects.

User-Defined Objects IFC Tag

Column IfcColumn

Column Wrap (Architectural column) IfcCovering

Comm Device IfcDistributionFlowElement

Curtain Wall (Straight & Curved) IfcCurtainWall

Curtain Wall Frames IfcMember

Curtain Wall Panels IfcPlate

Door IfcDoor

Drilled Footing IfcFooting

Existing Tree IfcBuildingElementProxy

Fence IfcRailing

Fireplace IfcDistributionFlowElement

Floor IfcSlab

Framing Member IfcBeam

Guardrail (Curved & Straight) IfcRailing
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User-Defined Objects IFC Tag

Handrail (Curved & Straight) IfcRailing

Landscape Area IfcBuildingElementProxy

Lighting Fixture IfcDistributionFlowElement

Retaining Wall IfcWall

Massing Model IfcBuilding

Mullion IfcMember

Parking Spaces IfcSpace

Pilaster IfcColumn

Pillar IfcColumn

Piping Run IfcDistributionFlowElement

Plant IfcBuildingElementProxy

Ramp IfcRamp

Receptacle (electrical) IfcDistributionFlowElement

Roadway (all types) IfcTransportElement

User-Defined Objects IFC Tag

Roof IfcRoof (contains instances of IfcSlab)

Roof Face IfcSlab

Seating Layout IfcFurnishingElement

Round Wall IfcWall or 
IfcWallStandardCase

Wall IfcWall or 
IfcWallStandardCase

Site Model (terrain surface) IfcSite

Slab IfcSlab

Stair IfcStair

Switch (electrical) IfcDistributionFlowElement

Table IfcFurnishingElement

Tables and Chairs IfcFurnishingElement

Outdoor Plumbing Fixture IfcFlowTerminal

Window IfcWindow

http://vectorworks.net
http://vectorworks.net


 15 BIM Interoperability for Landscape Architecture: IFC Exchanges in Vectorworks Landmark

When exporting architectural objects, such as doors, geometric 
information (width, height, opening direction, etc.) is automatically 
exported, as it is based on the physical geometry of the object.  
This way, model checking applications like Solibri can find collisions 
with other geometry, such as columns, low ceilings, or MEP elements 
like pipes or ducts. When these objects have a default IFC tag, they  
are also assigned an appropriate default property set associated  
with the IFC object. For example, a default door object is tagged as  
an IfcDoor and has the IfcDoor property set associated with it (Fig. 16). 
Other property sets can be assigned to the object as needed. For most 
landscape objects, there may not be this amount of pre-set tagging, 
however the tagging of additional pSets can be included to be exported, 
along with the represented geometry.

This guide covers the behavior of some default objects to help 
professionals understand the process of assigning and managing  
IFC data and the IFC export within Vectorworks. Not all objects will be 
covered in detail. The hope is that with a better understanding of the 
IFC export behavior, the user will be able to troubleshoot any problems 
that arise due to missing data and/or geometry.

BIM COLLABORATION WITH IFC

FIGURE 16: Multiple default pSets attached to a Door object
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THE IFC DATA DIALOG BOX

As mentioned before, nearly all smart objects in Vectorworks  
will already have a default IFC property definition assigned to them, 
however specific data about the object can and should be added.  
Use the IFC Data dialog box to assign, view, and edit IFC data 
associated with an object.

TO ACCESS THE IFC DATA DIALOG BOX:

1.	 Select the object (multiple items can be selected).

2.	 Select the menu Landmark → Architectural → IFC Data  
(if using Designer: AEC → IFC Data).

If the selected object does not have IFC data assigned to it, the  
Select IFC Object dialog box will open (Fig. 17). This will prompt  
you to choose the IFC designation for the selected object(s).  
See the Assigning IFC Data to Objects section of this document. 

If the selected objects already have an IFC designation,  
the IFC Data dialog box will appear (Fig. 18).

BIM COLLABORATION WITH IFC

FIGURE 17 & 18: Select IFC Object Dialog and IFC Data Dialog

http://vectorworks.net
http://vectorworks.net
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THE IFC DATA DIALOG BOX WILL DISPLAY FOUR KEY ITEMS:

1.	 An object’s IFC tag, or designation, and GUID (Global Unique 
Identifier) (Fig. 18A).

2.	 The data sets assigned to the object, referred to as property sets,  
or pSets (Fig. 18B). A check mark under the Use column indicates 
that this data set is attached to the object.

3.	 The properties or values for the selected Data Sets and whether  
the value is by instance or by style (Fig. 18C).

	∙ A by instance icon indicates that the property value comes  
from either the value set within the IFC Data dialog box or  
an equivalent Vectorworks object parameter (a default value).

	∙ A by style icon indicates that the property value comes from  
a custom data mapping that is defined by the user. See the  
IFC Data Mapping Command section. 

For more detailed information 
regarding the available fields  
in the IFC Data dialog box, visit 
Vectorworks online Help.

ASSIGNING IFC DATA TO OBJECTS 

When a Vectorworks project is 
exported as an IFC file, Vectorworks’ 
default site and building objects and 
the majority of default library symbols 
that have pre-assigned IFC data are 
exported as IFC objects. However, 
custom-made objects, or user-defined 
objects, are not exported unless they 
receive IFC assignments prior to 
export. Assigning IFC data to an object 

BIM COLLABORATION WITH IFC

FIGURE 18A FIGURE 18B FIGURE 18C
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does not alter it in any visible way within Vectorworks. The object  
can still be edited with standard Vectorworks tools and commands.

IFC assignments can be performed with the IFC Data command  
or with the IFC Data Mapping Command.

TO ASSIGN IFC DATA WITH THE IFC DATA COMMAND:

1.	 Select the object, group, or symbol instance (symbols that have 
been placed in the drawing) for assignment of IFC data (multiple 
items can be selected) (Fig. 19a).

2.	 Select the menu Landmark → Architectural → IFC Data  
(if using Designer: AEC → IFC Data).

Alternatively, you can access the IFC Data dialog box by selecting 
an object and clicking the Data pane at the top of the Object Info 
palette (OIP). Then click the Attach IFC button found near the 
bottom of the palette (Fig. 19b).

3.	 The Select IFC Object dialog box opens, listing available IFC object 
types (Fig. 19c). You have the ability to first choose which version 
of IFC to apply. Select the IFC object type to assign to the building 
object. Most entities supported by Vectorworks for export can be 
found in the Simple List.

BIM COLLABORATION WITH IFC

FIGURE 19A: Wall coping (extrude selected)

FIGURE 19B (LEFT): Attach IFC button in OIP

FIGURE 19C (RIGHT): IFCWall chosen in Select IFC Object dialog

http://vectorworks.net
http://vectorworks.net
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If you are using the Filter List option, please keep in mind that  
Filter List is not a Search function and cannot find a corresponding  
IFC tag for objects. For example, you cannot type in “toilet” and 
have the IfcFlowTerminal tag returned. To find the correct IFC tags 
for typical building objects, See the IFC Object Tags for Standard 
Objects section to find the correct IFC tags for typical buildings  
or to tag custom-made objects.

4.	 Select the IFC object type and click OK. The IFC Data dialog  
box opens in the Object Info Palette (also can be seen similarly  
in Properties dialog) (Fig. 19d). Under Record Formats,  
select the property set to attach to the IFC object by adding  
a check mark under the Use column. You can select multiple 
property sets. To enter the desired values for the properties  
of the selected data set, use the second pane to select  
the property and the String value field.

If you are attaching a custom property set to a unique instance  
of an object, select the Manage Custom Property Sets button  
(see the When to Use Custom IFC Property Sets section for  
more information).

5.	 Click OK to assign the IFC data to the object. The Data Pane  
of the Object Info Palette (or Properties dialog) will now display  
the selected object’s IFC Entity type and the associated property 
sets (Fig. 19e).

6.	 When attaching data to a symbol, it may be easiest to do so  
from within the active file resources in the resource manager. 
Simply right clicking on the symbol invokes the context menu  
where IFC Data should be selected. Add data by choosing the  
IFC tag and ensuring that there’s a check mark before the proper 
pSet. Once accepting the added data by clicking OK, a notice will 
assure you that the data will be attached to all existing and future 
instances of that symbol (Fig. 19f). This means that any future 
placement of the symbol will include the data as well.

BIM COLLABORATION WITH IFC

FIGURE 19D (LEFT): IFCWall pSet chosenenabling IFC fillable data fields

FIGURE 19E (RIGHT): IFCWall pSet fields populated before saving
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VIEWING AND EDITING IFC DATA

The data attached to Vectorworks objects or IFC entities, whether 
created in Vectorworks or imported from an IFC file, can be viewed  
and edited with the IFC Data command or from the Data pane of  
the Object Info palette.

TO ACCESS IFC DATA FOR EDITING THROUGH THE IFC DATA COMMAND:

1.	 Select the IFC Entity or Vectorworks object (multiple items  
can be selected).

2.	 Select Landmark → Architectural → IFC Data  
(if using Designer: AEC → IFC Data).

3.	 When the items to be edited have been specified,the IFC Data  
dialog box opens. View or edit the IFC data as described in the 
Assigning IFC Data to Objects section.

If an IFC Entity is selected, the IFC Data dialog box displays the data 
attached to the entity as described in the previous Assigning IFC Data 
to Objects section.

Creating a group containing multiple objects with differing IFC object 
types is not recommended. Doing so will result in the IFC tag assigned 
to the group not being assigned to the individual objects. In other 
words, the objects within the group will retain their respective IFC tags. 

BIM COLLABORATION WITH IFC

FIGURE 19F: Assigning IFC data to symbols within file

http://vectorworks.net
http://vectorworks.net
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If a symbol contains multiple objects with different IFC object types,  
a property set cannot be set to the symbol definition or symbol  
instance itself. Instead the objects within the symbol should be  
grouped and the appropriate property set can be attached to the  
group within the symbol.

The source of specific data values for a property set’s parameters can 
be determined by the Data Source field at the bottom of the IFC Data 
dialog box.

TO ACCESS IFC DATA FOR EDITING THROUGH THE OBJECT INFO PALETTE:

1.	 Select the IFC Entity or Vectorworks Object (multiple items  
can be selected).

2.	 Click the Data pane in the Object Info palette. The assigned IFC 
entity type displays at the top of the palette (Fig. 20). All default 
property sets for the IFC entity display below the entity type name. 
Property sets in use will have a check mark to the left of the 
property set name.

3.	 To add an additional property set, click in the left column  
to add a checkmark next to the property set.

4.	 Once the property set is added, the values for the parameters  
of the set displays below the buttons (Fig. 20). Some fields can be 
filled out directly. If the parameter field is grayed out and cannot be 
accessed, this indicates that the parameter is populated by either 
a predefined default mapping from an object parameter, or from  
a user-defined mapping (see the IFC Data Mapping Command 
section of this document).

5.	 Remember that any data added 
through the Object Info palette or 
through the IFC Data dialog is only 
applied to that instance of the object.

IFC DATA MAPPING VIA  
THE DATA MANAGER COMMAND

The IFC Data Manager command allows 
the user to define what parameters  
(and corresponding values) of an object 
are transferred to an identified, parallel 
IFC data set. In essence, this command 
allows customized control of data 
transfer from Vectorworks objects  
to IFC objects.

BIM COLLABORATION WITH IFC

FIGURE 20: IFC data editing through 
the Object Info Palette
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The command gives you the ability to:

	∙ Map non-IFC objects with a defined set of IFC parameters 

	∙ Map a Vectorworks object parameter value to the equivalent  
IFC parameter 

	∙ Attach property and data sets to objects in addition to the  
default IFC property set 

	∙ Identify which specific object parameters or record format 
parameters should map to an IFC parameter within the  
identified property set 

	∙ Define, save, and recall multiple various custom mapping 
configurations as a saved setting 

The IFC Data Manager command allows the user to edit or  
redefine the default IFC tag or assignment for all default objects  
within Vectorworks.

This command also allows you to set a default IFC assignment  
for all custom-made objects. From here, you can define what  
additional property and data sets within the IFC assignment  
are used by default (Fig. 21).

In the third pane of the dialog box, users can define the mapping  
for the specific IFC parameters (Fig. 22). Find a full explanation  
of the IFC Data Mapping dialog box in Vectorworks online Help. It is  
highly recommended to read through the online Help to understand  
the purpose of all parameters and settings in this command.

BIM COLLABORATION WITH IFC

FIGURE 21: 2nd pane of the Data Manager dialog box

FIGURE 22: 3rd pane of the Data Manager dialog box
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WHEN TO USE THE IFC DATA MAPPING COMMAND

There are multiple instances in which the IFC Data Mapping  
command should be used.

1.	 When additional data needs to be added to an object’s default  
IFC assignment 

A number of Vectorworks objects will contain user-defined data that 
are not included as part of the default IFC assignment. For example, 
the common name and botanical name of a plant are automatically 
mapped to the “name” and “object type” fields within its IFC Data Set 
(IfcBuildingElementProxy pSet) respectively, however the “Description” 
field is not yet populated. This is an opportunity for user-defined data 
describing the plant to be mapped to this field.

To show the Define Mapping dialog, select the “Description” Data Field 
and choose the Define Mapping button at the bottom of the 2nd pane. 
Because the data can be mapped from the plant’s existing Record 
Format, select this option for the Initial Field Value, then Plant  
Record.Category for the next pull-down menu. Since the “Category” 
within the plant’s data record describes the type of plant, this is  
most appropriate (Fig. 23).

By clicking OK, the plant’s category (description) will now be added  
to the IFC Data Set to accompany this plant object (Fig. 24). Note that 
the greyed-out tone of the text and the field indicate this is now being 
provided by the object’s data automatically.To change this moving 
forward, change the category data or re-define the mapping. 

2.	 When data from a custom record format needs to be mapped  
to an IFC property set

In Vectorworks, custom data records are attached to objects  
(default objects, plug-in objects, and custom-modeled objects)  
using record formats (Fig. 25). For detailed information on  
creating custom record formats, go to Vectorworks online Help. 

BIM COLLABORATION WITH IFC

FIGURE 23 (LEFT): User-defined mapping in the Data Manager’s 2nd pane

FIGURE 24 (RIGHT): User-defined data now in Description field of the IFC Data Set
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BIM COLLABORATION WITH IFC

The parameters of a custom record format can be mapped to  
the correct corresponding IFC property set. For example, it is easy 
enough to define the weight of a proposed rooftop plant as-installed  
— but what if the architect and structural engineer request to know  
the plant’s projected weight at 10 years and 20 years past installation?  
This is a great example of how the custom record format for this  
data will need to be attached to the object in the IFC file, so that  
the collaborators can have this data on each plant object.

Using the same data mapping processes shown above, say the  
user wants to add a new Data Set within the IFC Data Sets in  
the Data Manager. Clicking the Add Data Set button activates  
the Add Data Set dialog, where the IFC pSets (Custom) is chosen  
to then pick the Weight Installed & Future Record Format.  
If this Record Format does not show at first, this can be added via  
the Manage Custom Property Sets button. The parameters for  
these records can be mapped to the identified IFC Classification  
data set to ensure that the data is transferred during an IFC  
model exchange (Fig. 26).

3.	 When custom-made objects or symbols need a default IFC 
assignment and property sets attached 

This is directly related to the second use of the IFC Data Mapping 
command described above. IFC assignments and property sets  
can be defined for all custom-made objects, ensuring that each time  
the custom object is placed in the file, it will receive that appropriate 
IFC tag assignment.

4.	 When file exchange requirements include mandatory  
or default IFC values 

There are some scenarios when BIM data exchange has specific 
requirements that need to be fulfilled. Some of these requirements 
may specify that every data field needs to have a default value or  
that certain data fields should not be left empty.

FIGURE 25 (LEFT): Custom Record Format

FIGURE 26 (RIGHT): Adding Custom Record Format as and IFC Data Set
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BIM COLLABORATION WITH IFC

USING THE IFC DATA MANAGER FOR COBIE REPORTS

The Construction Operations Building Information Exchange (COBie), 
an international standard related to asset management, is a sub-set  
of IFC that’s focused on delivering asset data, especially for 
maintainable assets. It is divided into several data subsets  
which include Contact, Type, Component, System, and Attribute.

Strictly speaking, COBie is a dataset and can be contained in 
a database. Plainly speaking, it is a set of worksheets with a 
predetermined layout, showing the data embedded in a model.  
It will contain object information and quantities needed for  
continuous maintenance of the asset.

To report on content using the COBie worksheet structure, set up  
the desired data sets using the Data Manager, just as for other  
IFC information. Vectorworks ships with a COBie datasets schema  
right out of the box.

Under Settings at the top of the Data Manager, select  
<COBie Defaults>. The workflow is the same as for normal  
IFC data sets (Fig. 27a).

Just as for IFC, Vectorworks comes already loaded with COBie  
record formats attached to most parametric objects. If you are  
required to report on objects without these attached, you can  
add them via the Data Manager.

Vectorworks also comes with a set of pre-made COBie reports  
(Fig. 27b). These are mainly intended to be used as pre-flight,  
pre-checking reports, prior to exporting the data through the  
IFC file export.

FIGURE 27A: Vectorworks’ Data Manager provides mapping opportunities for COBie
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BIM COLLABORATION WITH IFC

FIGURE 27B: COBie report generated from Vectorworks from a preconfigured worksheet
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EXCHANGING IFC FILES WITH VECTORWORKS LANDMARK

Aside from the data transmitting in a BIM file exchange, it is also very 
important for the geometries within a shared IFC file to be positioned 
correctly. Whether importing a building context model in IFC format or 
exporting the proposed landscape model in IFC format, the “point of 
origin” or “project base point” must be the same. Once the site file is 
either geolocated or aligned to the survey file by its user origin within 
Vectorworks, then a common reference point — such as the corner 
of the imported building — should be established. If geolocated, this 
may be its latitude and longitude or easting and northing, or at least 
the same “X and Y,” to be sure the geometry lines up. Elevational 
positioning, which will also be addressed in the sections related to 
model preparations, is crucial to the exchange as well, especially  
for projects where landscape is designed over structure.

EXPORTING IFC FROM VECTORWORKS
Generally, Vectorworks Landmark files are exported as entire projects 
(proposed landscape on site terrain and/or on structure) to be 
exchanged or analyzed with other IFC-compatible applications. When 
you use the Export IFC Project command, you assign design layers to 
landscape hierarchy. Mapping can also be controlled manually, letting 
you override or edit the automated process. The manual process is also 
used if you have chosen not to use Vectorworks’ story organization. 
Keep in mind that when the layers are mapped manually, the last 
mapping settings are retained by Vectorworks. You will only need  
to map layers again if you add any new layers.

MODEL PREPARATIONS

The following guidelines may be useful when preparing your model  
for export:

	∙ Take care to set up the elevation values of layers correctly.  
Verify that all the objects in the drawing are vertically aligned  
as necessary.

	∙ If you are using standard Vectorworks plug-in objects, it is best  
to use those listed in the IFC Object Tags for Standard Objects 
portion of this guide.

	∙ Use the IFC Data command to attach IFC data to custom symbols 
and objects, so that they will be recognized at IFC export.

	∙ Use the Choose Schedule command to generate IFC schedules  
for default objects or create your own schedules to verify and 
correct the IFC data attached to objects (be aware that these 
schedules are not bi-directional).

FOR FASTER EXPORT PERFORMANCE, BEFORE EXPORTING:

	∙ Set the 3D Conversion Resolution lower to optimize the file  
size. Accomplish this by following the path Tools →  
Options → Vectorworks Preferences → 3D → 3D conversion 
resolution → Low.

	∙ Select only the layers you want exported by using the  
Export Visible Objects Only option on the Export IFC  
Project dialog box’s Data tab. 
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EXCHANGING IFC FILES WITH VECTORWORKS LANDMARK

	∙ Set the model to Top/Plan view before exporting.

	∙ Zoom your view into a small, simple corner of your  
model before exporting.

TESTING IFC EXPORTS

Test the quality of the IFC export file by verifying it in an IFC model 
browser. Almost all free IFC browsers can view and validate the  
model, but they may be more limited in capabilities when compared  
to paid packages. Some examples of free IFC browsers include:

Solibri Model Viewer Macintosh or Windows

FZKViewer Windows

DDS-CAD Viewer Windows

Trimble Connect 
(Formerly Tekla BIMsight)

Macintosh or Windows

Constructivity Model Viewer Windows

RDF IFC Viewer Windows, Macintosh  
(Linux versions planned)

IFC WebServer Web browser

xBIM Xplorer Windows

IfcPlusPlus Windows

DESITE BIM N/A

For more information regarding IFC viewers and other IFC-compatible 
applications, visit the buildingSMART IFC-Compatible Implementations 
Database or IfcWiki.org websites.

Vectorworks project files can be exported to .ifc, .ifczip, and  
.ifcxml formats.

Export to IFC Versions 2x2, 2x3, and 4 is supported, but version 2x3  
is most commonly used in current practice. The export of a project  
to an IFC file is based on specifying the geometry and associated data 
needed for the use of the exported file. This specification is called  
a Model View Definition (MVD). Vectorworks software supports the  
use of MVDs to automate the export, or the user can manually define  
a custom set of geometry and data to be exported.

TO EXPORT A VECTORWORKS FILE TO IFC

1.	 Select File → Export → Export IFC Project.

The Export IFC Project dialog box opens (Fig. 28).

2.	 Under the Data tab, you’ll see a number of options for specifying 
the export options as well as the overall project information,  
such as project data, author data, site data, and building data.  
Any required field within this tab will be automatically filled  
based on the existing Vectorworks project information.

http://vectorworks.net
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EXCHANGING IFC FILES WITH VECTORWORKS LANDMARK

For Export Options, select IFC version 2x3 (the default) and the  
CV 2.0 – Architecture Model View (also the default). This particular 
Model View is an official buildingSMART international view for 
exporting architectural models for coordination with structural  
and MEP models.

If you have created any custom property sets, make sure that  
the Export Custom Property Sets box is checked (this should  
also be checked by default).

To better understand all the parameters within the Data tab  
of the dialog box, please visit Vectorworks online Help.

3.	 Click the Layer Mapping tab to specify which layers to export,  
then click the Vectorworks and IFC Site (Story) Name to assign  
to them at export (Fig. 29).

If a site model is set to a site layer and has been tagged for IFC,  
it will also be included.

Mapping can also be controlled manually. Specify the associated 
building or site data for each of the mapped layers.

To better understand all the parameters within this tab of the  
dialog box, please visit Vectorworks online Help.

FIGURE 28: Export IFC Project dialog box – data tab FIGURE 29: Export IFC Project dialog box – layer mapping tab confirms which layers will export
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4.	 Click OK to export the project.

Indicate the file name and location in the Save As dialog box.  
Be sure to append the file name with the .ifc file extension. 

IMPORTING IFC INTO VECTORWORKS

IMPORTING IFC

Even IFC projects containing multiple buildings or large information 
sets can be imported into a Vectorworks file. The units of the imported 
file are determined by the Vectorworks file settings. An important  
thing to understand is that the file’s original presentation layers or 
CAD layers from an imported IFC file are assigned to corresponding 
Vectorworks classes. Also, the Import IFC command automatically 
assigns IFC building stories to their own design layers.

TO IMPORT AN IFC FILE:

1.	 Select File → Import → Import IFC

2.	 Select the .ifc, .ifczip, or .ifcxml file to open, and click Open.  
The IFC import can be filtered based on elements or stories. 

3.	 Alternatively, click the file to import and drag it into a window  
with an open Vectorworks document.

4.	 All IFC Stories and elements are imported by default. However, 
a filter can be applied to choose specific Stories or particular 
elements (Fig. 30).

5.	 If Stories is selected, a list of all stories in the IFC file will be 
displayed. Stories with the designated check mark to the left  
are marked to be imported. If a story needs to be removed,  
click on the check mark to remove it and exclude the story  
and all its elements from being imported.

EXCHANGING IFC FILES WITH VECTORWORKS LANDMARK

FIGURE 30: Select IFC Stories and Elements dialogs
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6.	 If Elements is selected, a list of all IFC elements in the IFC file will 
be displayed along with the number of elements. Follow the same 
process as with Stories to include or exclude particular elements.

7.	 Click OK. The file will be imported.

By directly importing the IFC, the imported geometry and appended 
IFC data not only become visible, the site designer can select geometry 
and identify labeled objects and materials all while incorporating the 
collaborators’ models to better inform their comprehensive analysis  
of the site with building and other structures.

Imported models and elements can react to Vectorworks’ visibility 
controls, such as turning specific layers on, off, or grayed. These 
custom visibility settings help the designer to either view everything, 
isolated floors while others are off, or perhaps see selected floors 
prominently while others are grayed (Fig. 31).

For more detail on the IFC file import options, visit Vectorworks  
online Help.

REFERENCING IFC

Similar to directly importing an IFC file, using a referenced IFC import 
will provide the context from the project’s design collaborators (i.e. 
building and infrastructure) but adds the opportunity to incorporate 
revisions from the collaborator/s via the referenced IFC file.  
This is much like how an external DWG file, when referenced,  
can be routinely updated.

Within Vectorworks’ Navigation Palette, the user can simply select  
the References tab, then right-click on the IFC file’s reference in  
the list to get the context menu. Within the context menu, the designer 
then clicks on the Update option to then see the referenced IFC model 
update with the collaborators’ exported updates (Fig. 32).

Once imported, should the user opt to import each story as a 
referenced design layer, they can choose the Layer Import setting 
through the Organization dialog box (Fig. 33). This enables creation  
of separate viewports with varied stories turned on or off.

EXCHANGING IFC FILES WITH VECTORWORKS LANDMARK

FIGURE 31: Imported IFC Stories with changed visibilities
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EXCHANGING IFC FILES WITH VECTORWORKS LANDMARK

FIGURE 32: Referenced IFC model updated after change received

FIGURE 33: Utilizing Layer Import in the reference settings  
provides visibility controls to imported stories via design layers. 
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ANALYZING IMPORTED AND REFERENCED IFC FILES

The always-expanding opportunities for analysis of a BIM project 
actually extends to imported IFC files, both directly imported and 
referenced. This is because the data that comes appended with the 
geometry in the shared files can continue to be of use to the site 
designer. If designing landscapes on structure, for example, the 
landscape architect’s or landscape designer’s work will certainly 
be reviewed by the architect and structural engineers to be sure the 
design does not clash or risk structural failure. Because Vectorworks 
Landmark is suited for design development analysis, the ability to 
analyze the building or structure to be proactive in the proposed 
solution is an essential step.

Below are some examples of ways in which an imported IFC model 
can be analyzed within the site design firm’s workflows in Vectorworks 
Landmark, as if they were analyzing their own project, using Data 
Visualization and Clip-Cube features (Fig. 34).

EXCHANGING IFC FILES WITH VECTORWORKS LANDMARK

FIGURE 34: Referenced IFC building model analyzed for material,  
load bearing walls and support column positions change received
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CONCLUSION

As the only stand-alone software application that offers integrated 
2D/3D information modeling (BIM) specific to landscape architecture 
and site design, landscape architects, landscape designers, and land 
planners have a powerful BIM tool for the landscape in Vectorworks 
Landmark. This becomes even more powerful when incorporating 
Open BIM interoperability with IFC files. Whether importing to aid in 
the contextual understanding of how the collaborators’ building and 
other structure work inform the landscape solution, or by exporting  
to share the proposed landscape with those same collaborators to aid 
in a more cohesive approach to building, structure, and site, firms will 
undoubtedly appreciate the efficiencies of Open BIM workflows with 
IFC interoperability.

The Vectorworks development team looks forward to continuing 
future IFC exchange support and development. Users can expect 
ever-improving interoperability, not only with BIM solutions, but with 
geospatial integration opportunities as well. With this in mind, users 
are always encouraged to share input, insight and inspiration for how 
BIM integrations can improve. Please use the contact information 
provided in the end of the guide to share input.

FIGURE 35A: Example of landscape over structure via referenced IFC model of building

FIGURE 35B: Example of referenced IFC model of building within the proposed landscape 
(Site design by PWP Landscape Architecture)
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OTHER RESOURCES AND INFORMATION

There are multiple places online to access more detailed information 
regarding IFC and buildingSMART, the entity that oversees IFC.

You can visit the IFC Wiki page here.

You can also access a full list of the different software that are  
IFC certified by buildingSMART here.

Information regarding Model View Definitions and the standardization 
of Exchange Requirements by buildingSMART can be found here.

Helpful resources to understand the IFC Entity data schemes  
and their corresponding property sets are also available online.

For IFC 2x3, they can be found here.

For IFC4 Reference View, they can be found here.

http://www.ifcwiki.org/index.php?title=IFC_Wiki
https://technical.buildingsmart.org/resources/software-implementations/
https://technical.buildingsmart.org/standards/ifc/mvd/
https://standards.buildingsmart.org/IFC/RELEASE/IFC2x3/FINAL/HTML/
https://standards.buildingsmart.org/IFC/RELEASE/IFC4/FINAL/HTML/
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TERMINOLOGY

IFC (INDUSTRY FOUNDATION CLASSES)

A platform neutral, open file format that is not controlled by  
a single software vendor or a group of vendors. It is an object-based  
file format with a data model developed by buildingSMART to facilitate 
interoperability in the AEC industry. It is a commonly used collaboration 
format in BIM-based projects.

OPEN SOURCE FILE FORMAT 

A format whose technology is freely available to the public  
for development.

STANDARDIZED FILE FORMAT

A format that follows a standard way that information is encoded  
for storage in a computer file. It specifies how bits are used  
to encode information in a digital storage medium.

SEMANTIC OBJECT

A representation of a collection of attributes that describe an 
identifiable object. This means that the model describes the meaning 
of instance. The support of semantic objects is what makes IFC ideal 
for an open BIM exchange.

DYNAMICALLY EXTENSIBLE

The principle of being able to dynamically change or load in new 
information without changing the existing information. Adding new  
IFC information to an existing Record Format is a good example of this.

EXTENSIBILITY

A design or coding principle that takes future growth into 
consideration. Extensions can be through the addition of new 
information or through modification of existing functionality.  
IFC is an extensible file format in that new information can be  
added to existing information or existing information can be modified. 

IFC OBJECT TAG

A label or tag that helps identify an IFC object.

IFC OBJECT TYPE

An object that has been identified as building element  
with the corresponding IFC tag.

PROPERTY SET

Attributes that define a particular type of object. IFCPropertySets  
are a collection of predefined attributes that are used to define  
an object. Property sets are also referred to as pSets.

CUSTOM PROPERTY SET

User-created/defined property sets.

MODEL VIEW DEFINITION (MVD)

Also called an IFC View Definition, a Model View Definition  
defines the IFC information needed to satisfy.

http://vectorworks.net
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